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1. INTRODUCTION

Thank you for choosing the ZL6 data logger from METER Group.

The ZL6 loggers are part of the ZENTRA System, a collection of data loggers, software, and
compatible sensors to measure environmental parameters accurately and cost effectively.
Please refer to ZL6 specifications at metergroup.com/zl6-support for a list of supported
sensors.

The ZL6 is a self-contained, plug-and-play data logger for field research and commercial
agriculture. It is housed in a weather-resistant enclosure, making it suitable for long-term
outdoor operation. The logger includes built-in circuitry to charge nickel-metal hydride (NiMH)
batteries using energy from two integrated solar panels. Collected data are transmitted to the
ZENTRA Cloud web service via cellular communication.

Verify all instrument components are included and appear in good condition:
» ZL6 series logger

« Device subscription sticker (inside the logger)

« Six rechargeable NiMH batteries

* Micro-USB communications cable

» UV-stable plastic zip ties

« Stainless steel zip ties

« USB drive containing ZENTRA Utility software installer

 Spare parts kit, including an additional gasket and thumb screw


http://www.metergroup.com/ZL6-support
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2. OPERATION

This section explains the basic workflow of logger installation, logger configuration, and data
download. Please read all instructions before operating the ZL6 to ensure it performs to its
full potential. Consider testing the ZL6 and sensors in a lab or office prior to field installation
to verify the correct operation of the system.

The ZL6 can serve as a data collection station for as many as six sensors. It is designed for
plug-and-play setup with all METER sensors, including the ATMOS weather sensors, TEROS
soil moisture sensors, HYDROS water sensors, PHYTOS leaf sensors, and ECH, 0 soil moisture
sensors. Please refer to the individual sensor manuals for sensor installation instructions.

NOTE: Neverimmerse the ZL6 in liquids or bury the ZL6. This and other misuse, improper protection, orimproper
installation may damage the ZL6 and void the warranty.

2.1 INSTALLATION
Follow the steps listed in Table 1 to set up the ZL6 and start collecting data.

Table 1 Installation

Microsoft® Windows® or Apple® Mac® computer

Tools Needed Mounting post (or similar)
Install ZENTRA Utility
Use the included USB drive to install ZENTRA Utility:
« On a Windows computer, open the My Computer window, select the USB
drive, and double click on ZENTRA Utility PC Installer.exe.
« On a Mac computer, using Finder®, select the USB drive, and double click on
ZENTRA Utility Mac Installer.pkg.
Alternatively, use the ZENTRA Utility Installer link on the ZL6 webpage
Preparation (metergroup.com/ZL6-support).

The installer automatically installs the necessary USB driver for the ZL6.
Install Batteries

NOTE: Alkaline batteries will not be recharged by the solar battery charger.

The status lights will eventually settle to a green short, single blink every 5 s,
signaling it is ready for use.

Configure the ZL6 Using ZENTRA Utility

NOTE: This step can also be done in the field.

Connect the micro-USB cable to a computer and logger.
Configuration
Open ZENTRA Utility and select Connect (Section 2.2).

Set the measurement interval and verify the ZL6 is correctly configured for the
sensors that will be installed.


http://www.metergroup.com/ZL6-support
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Table 1 Installation (continued)

Select Location

Choose a location and orientation to give the solar panel the maximum amount
of sunlight. In the northern hemisphere, this will typically mean the data logger
will face south;in the southern hemisphere, this will typically mean the data
logger will face north.

Additional location considerations may include vegetation cover throughout the
season, distance from power lines, minimal livestock, etc.

NOTE: If the location is in an area where solar energy harvesting is minimal, alkaline
batteries will power the logger longer than the NiMH batteries when not being recharged
by the solar panel. The ZL6 does not charge alkaline batteries.

Evaluate how surroundings may attenuate the cellular signal. Do not install the
ZL6 near large metallic objects.

Check Cellular Communication Quality

Use ZENTRA Utility to check the quality of the cellular signal (Section 2.3).

If the signal is low or cellular test fails, move to an alternative location
(sometimes moving only a few meters is sufficient).

Fasten Logger to Mounting Post
Use the loopholes on the top and bottom of the logger enclosure to mount the
ZL6 to a post using the zip ties or a similar fastener (such as hose clamps).

Ensure the logger is installed in an upright position to reduce the possibility of
water entering the ZL6 enclosure.

NOTE: The ZL6 case is water resistant, not waterproof. In extremely wet environments or
environments with prolonged high humidity, place a desiccant packet inside the logger or
enclose the logger in a waterproof case.

Install Sensors
Install each sensor as directed in the sensor user manual.

Thread cables near the ground through conduit or plastic cladding to avoid
rodent damage.

Plug the sensor stereo plug connectors firmly into the ZL6 input ports.

Put each cable in the corresponding strain relief hook and use thumb screws to
tighten strain relief hook.

Perform instantaneous scan to ensure sensors are working properly
(Section 2.4).

NOTE: The spare parts bag was designed to be stored in the logger to be available
if needed.
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2.2 CONFIGURATION

The measurement interval and sensor types must be set before data will be stored by
the logger.

To configure the ZL6 in ZENTRA Utility, refer to the following steps:
1. Plug the micro-USB cable into the logger USB port and the computer USB port.

2. Openthe ZENTRA Utility application (Figure 1).

|3 ZENTRA Utility (E=0EcH )

File Data Edit Actions Window Help

ZL6: ZENTRA ZL6 (COM11) ~ Connect

You are not connected to a device.

Ready

Figure 1 ZENTRA Utility initial screen

3. Onthe ZENTRA Utility main screen, select the appropriate COM port from the dropdown
menu (Figure 2). If the logger designation does not appear, try a different port or cable.
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£ ZENTRA Utility

File Datz Edit Actions Window Help

ZL6:
ZI

Connect

NTRA ZL6 (COM11) -

NTRA ZL6 (COM11)
Unknown: COM1

felle ==

You are not connected to a device

Ready

Figure2 COM port dropdown

4. Click the Connect button next to the COM port dropdown menu (Figure 2).

Once successfully connected, ZENTRA Utility displays the instantaneous sensor
measurements from the ZL6 (Figure 3).

{4 ZENTRA Utility
File Data Edit Actions Window Help

(=il =]

ATMOS 41 All-in-one Weather Station
Port1

TEROS 12 Moisture/Temp/EC

Solar Radiation
4 Wim*

Wind Direction
234°

Relative Humidit;
0.27RH

Max Precip Rate
0.00 mmih

Water Content

Precipitation
0.000 mm

Wind Speed
0.22mis

Atmospheric Pressure
93.20 kPa

RH Sengor Temp
TAT°F

Soil Temperature

ZL6: ZENTRA ZL6 (COM11) Disconnect Scan Download Settings Cellular Test
26-00004 i) Keldin Trials 1}
South Site 1.107 15 minutes < 1% in use. Approximately 3.7 years until overwriting old data

Lightning Activity Lightning Distance
o 0km

Gust Speed Air Temperature
0.24mls T4.8°F

X-axis Level Y-ais Level

1.4° 0.7°

Saturation Extract EC

port2 0.127 m*im* 725°F 0.005 mS/cm
Battery Battery Percent Battery Voltage
81% sa4gmv
Barometer Reference Pressure Logger Temperature
93.00kPa 75.0°F
Ready 04125/18 12:23:06

Figure 3 ZENTRA Utility showing a connected ZL6 and its instantaneous measurements
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5. Click the Settings button in the Button toolbar.
The Manage Settings dialog will appear.

6. Navigate to the Device Information tab (Figure 4).

Manage Settings ==
{Device information! | Sensor C Comn Settings  GPS Location

Device Name South Site

Site Name Keldin Trials

Serial Humber

Time Zone uTcy
Firmware Version 1107
Device Type L6
0K Cancel

Ready

Figure 4 Device Information tab

7. Enter a device name.
This field is prepopulated with the device serial number. Consider changing the name to
the field or plot where the ZL6 is installed.

8. Navigate to the Sensor Configuration tab (Figure 5).
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Manage Settings =2l
Device Information Sensor Configuration | Communication Settings | GPS Location
Measurement Interval 15 minutes -
Data Storage: 0.4%in use. - Approximately 3.7 years until overwriting old data
Portl [port2 [Port3 [Ports [Port5 [Ports |
Sensor Type [ ATMOS 41 All-in-one Weather Station e
Firmware Version 0
Ready

Figure 5 Sensor Configuration tab

9. Adjust the Measurement Interval to the desired time for storing sensor measurements.
Section 3.2.2 provides more information on how the ZL6 makes measurements.

10. Confirm all sensors are plugged into the ZL6.

11. Ensure the correct sensor type is listed in each port tab (Figure 6).

If the sensor is not automatically recognized, pick the correct sensor setting from the
Sensor Type dropdown menu.

NOTE: Check the cellular signal (Section 2.3) at the expected installation location before installing sensors.
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Manage Settings 2|

Device Information Sensor Configuration | Communication Settings | GPS Location

Measurement Interval 15 minutes

Data Storage: 0.4%in use. - Approximately 3.7 years until overwriting old data

Portl [port2 [Port3 [Ports [Port5 [Ports |

Sensor Type ATMOS 41 All-in-one Weather Station

ATMOS 41 All-in-one Weather Station
Drainage and Depth
G1/G2 Drain Gauge
G3 Drain Gauge
CTD+DG Drain Gauge
CTD Depth/Temp/EC
CTD-5 Depth/Temp/EC
CTD-10 Depth/Temp/EC
Electrical Conductivity
ES-2 Conductivity/Temp
ES-2F FullStop EC/Temp
Spectral Reflectance
SRS-Ni NDVI Hemispherical
SRS-Nr NDVI Field Stop
SRS-Pi PRI Hemispherical
SRS-Pr PRI Field Stop
Water Flow
ECRN-50 Volume
P3-1 Pressure Switch
PT100 Irrigation Pressure
FM-25/FM-40 Flow Meter

Generic Flow Meter =
Ready i

Firmware Version

m

Figure 6 Select Sensor Type dropdown
12. Navigate to the Communication Settings tab (Figure 7).

Manage Settings

Device Information Sensor Configuration | Communication Settings =~ GPS Location

Upload frequency for each selected hour:

O data upload per hour (default) -

Upload Times (Choose up to 6, chaose fewer to save battery ife)

—

T
1 1 1
Wy S \
VAN SE
1050 x| 1050 o2
=~ ~ =~ =
e
= T = 3
8~ 4 87 4
N o w7y o
. 7///fi‘1\\\\5/ \\7/”.H|1\\\\5/
e 8~ > 6

S

APN

APHN User

Ready

Figure7 Communication Settings tab
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Select the time segments in Upload Times by clicking the arc segments for the
hour intervals.

The ZL6 will upload data during the selected intervals (Section 4.2.5).
Click OK.

2.3 CELLULAR COMMUNICATION TEST

A successful communication test will confirm that the ZL6 can transmit data to servers as
well as provide the quality of the connection. Even a poor connection status allows data to
be successfully transferred. Prior to installing the sensors and the ZL6, check the cellular
connection at the location:

1.

Click the Cellular Test button in the Button toolbar.
The Cellular Communication Test dialog will appear (Figure 8).

Cellular Communication Test

Click the test button to test the cellular connection and data transfer between
'76-00004' and zentracloud.com

Signal Strength: 32%
Carrier: AT&T (roam)
Packet Attempts: 1

Status: Connection Quality: Excellent

‘ Close | I Test I

Figure 8 Cellular Communication Test dialog
Click Test.
If the logger fails the test, move to a new location and try again.
Sometimes, moving just a few meters will provide a successful connection.

NOTE: The ZL6 antenna is inside the enclosure. An antenna extension cable can also be used to elevate the
antenna for increased signal strength. Contact Customer Support for more information.

Click Close.

2.4 INSTANTANEOUS SENSOR MEASUREMENTS SCAN

ZENTRA Utility will automatically scan the sensors attached to the ZL6 every 30 s and
update the readings shown on the main screen (Section 4.2.2).

ZENTRA Utility can also take real-time sensor measurements with the ZL6 on demand.

This is a critical tool to ensure sensors are installed correctly, to test if a sensor is reading
properly, or to evaluate how sensors react to environmental changes. The ZL6 does not store
data that it measures with the scan function.
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To force a new scan to occur at any time, press the Scan button in the Button toolbar
(Section 4.2). The sensor and measurement area will refresh.

2.5 DATA DOWNLOAD

While at the installation site, allow the ZL6 to collect data for one or two measurement
intervals, and download the collected sensor data to ensure the monitoring setup is working
correctly. Periodically return to the site to download the stored data, to check the logger
operation, and to retrieve stored data.

Download saved sensor and status data with ZENTRA Utility using the following steps:

1. Connect the logger to a computer using the micro-USB cable.
2. Open ZENTRA Utility.

3. Choose the appropriate COM port from the dropdown list.
4. Click Connect.
5

Click DownTload on the Button toolbar. This will download the data stored since the last
successful download.

Alternatively, go to the Data menu in the Menu bar and select either Download New
(downloads the data stored since previous download) or Download A1l (downloads all the
data currently stored in the ZL6).

6. Edit the File Name in the Save dialog. A suggestion will appear, based on the connected
logger name and the time and date.

7. Select the location on the computer where the file will be saved.

8. Click Save.

ZENTRA Utility downloads sensor data and creates a Microsoft Excel® compatible file.
The time-series sensor data saves to the Processed Records sheet of the workbook with
metadata saved to the Metadata sheet. Metadata includes logger configuration settings,
logger location, and sensor metadata, such as serial number and firmware version.

ZENTRA Utility will download data in the units chosen under Measurements in Manage
Preferences dialog (Section 4.2.4).

ZENTRA Cloud can aslo be used to download stored data remotely (Section 4.3).

2.6 DATA DELETION

Itis not necessary to delete data on the ZL6. Once all of the memory has been used, the
ZL6 will start overwriting the data starting with the oldest records.

Erasing stored data is done with ZENTRA Utility. Before erasing data, download and save
data onto a computer. To erase data, follow the steps below:

1. In ZENTRA Utility, click on the Data menu on the Menu bar.

10
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2. SelectErase. A dialog will appear.

3. Click Erase Data to remove data or click Cancel to return to ZENTRA Utility without
removing data.

CAUTION: This feature permanently erases all stored data on the ZL6. Data previously transmitted to ZENTRA Cloud
are not erased.

1
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3. SYSTEM

This section reviews the ZL6 data logger hardware features and configuration options. Use
this information to help optimize each environmental monitoring setup.

3.1 SPECIFICATIONS

Sensor Input Ports
Sensor Port Type
Logging Interval
Reporting Interval
Data Storage
Memory Type

Global Position

GPS Position Update

GPS Position Accuracy
Timekeeping

Battery Capacity
NiMH Battery Charging
NiMH Battery Life

Alkaline Battery Life

Computer Communication

Cellular Specifications
Cellular Coverage

Internet Downloads
Enclosure
Enclosure Rating

Enclosure Size

6 (supports METER analog, digital, or pulse sensors)
3.5-mm stereo plug connector
5minto12h

Hourly with additional charges for more frequent reporting

8 MB (40,000 to 80,000+ records depending on configuration)

Nonvolatile flash, full data retention with loss of power
Integrated 56-channel GPS/QZSS receiver

Daily (automatic) and on-demand (manual)

+3 m, with good sky view

Synchronize automatically and on-demand;
GPS system, cellular, or software

6 AA NiMH or alkaline batteries

Solar energy harvesting or USB

3+ years with unobstructed view of sun

3-12 months depending on configuration
Standard USB cable, USB A to micro-B

UMTS 3G 5-band Cellular Module with 2G fallback

AT&T® and T-Mobile® in USA, 200+ global partner carriers.
Cellular and data hosting service provided by METER.

SSL/TLS encrypted

Weather-, impact-, and UV-resistant polymer
IP56, NEMA 3R

14.9cmx25cm x 6.3cm (5.9in X 9.9in x 2.51in)

12
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Enclosure Access Hinged door with latches and eyelets for lock or zip tie
Operating Environment —40 to +60 °C (0%—-100% relative humidity)
Compliance

Manufactured under ISO 9001:2015
EM ISO/IEC 17050:2010 (CE Mark)

3.2 ZL6 HARDWARE COMPONENTS

The ZL6 logger communicates through USB and through a Universal Mobile Telephone
Service (UMTS) cellular module. This allows remote configuration and environmental
measurement data transmission over a cellular network.

W

METER

- J
Figure9 ZL6 data logger exterior

The logger is housed in a weather-resistant enclosure (IP56 rated). In extremely wet
environments or environments with prolonged high humidity, enclose a desiccant packet
inside the logger or enclose the logger in a waterproof case.

13
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The ZL6 is purpose-built to collect data from environmental sensors sold by METER. The
data logger has six ports for sensors and a micro-USB port for communicating with a
computer (Figure 10). The data logger interior also contains a TEST button (Section 3.2.3) and
two status lights, OK and ERROR (Section 3.2.4). The logger uses six batteries, and solar cells
recharge NiMH batteries (Section 3.2.5).

]
[

7]

METER

ICF

o L
= — > 0

X - I 43
SeRwon <>TEST ﬁbg @

Port 1 Port2 Port3 Port4 Port§ Port 6

VFE;

la

NS

Figure 10 ZL6 data logger interior

3.2.1 SENSOR INTERFACE

The ZL6 will detect the presence of METER sensors when connected to the sensor ports. For
METER digital sensors, the ZL6 will detect and autopopulate the Sensor Type dropdown on
the Manage Settings dialog in ZENTRA Utility (Section 4.2.5). For METER analog sensors, the
ZL6 will show Unrecognized Sensor in the Sensor Type dropdown. Some sensors (such as
pulse sensors) will not be detected by the ZL6. In these latter two cases, the sensor will have
to be manually selected from the dropdown menu.

NOTE: Itis critical that the ZL6 is configured correctly for the attached sensors. Without correct configuration, the
ZL6 will not record useful sensor information.

The ZL6 is able to detect when many of the METER sensors are unplugged or malfunctioning.
The logger stores error codes in the place of normal sensor measurements in this event.

14
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ZENTRA software will display these errors to help troubleshoot problems with the sensors.
The ZL6 cannot determine the difference between an intentionally uninstalled sensor and a
malfunctioning sensor. Update the sensor configuration each time sensors are removed from
or added to the ZL6.

3.2.2 SENSOR MEASUREMENT INTERVAL

The measurement interval controls how often the ZL6 records sensor data to internal
nonvolatile data storage. The interval applies to all ports on the ZL6 (i.e., the ZL6 cannot
store data for one sensor at a faster rate than another sensor). This setting is controlled in
the Sensor Configuration tab of the Manage Settings dialog (Section 4.2.5).

The measurement interval works relative to the ZL6 internal real-time, 24-h clock. For
example, a measurement interval of 2 h results in the ZL6 storing data every 2 h, on the hour
(e.g., 12:00 am, 2:00 am, ..., 10:00 pm). The ZL6 minimum measurement interval is 5 min. The
maximum measurement interval is 12 h. For most applications, a measurement interval of
60 min is appropriate.

The ZL6 makes a measurement from each of the sensor ports in use every 60 s. When the
ZL6 internal clock reaches the user-configured measurement interval, the ZL6 processes
and stores the results from all the 60-s sensor readings taken since the last storage interval.
For most sensors, the stored results are a simple average of the per-minute readings. For
example, if the measurement interval for a TEROS 12 soil moisture sensor is 60 min, the

ZL6 stores an average of the past 60 sensor readings. For a pulse-based sensor, like a rain
gauge, the ZL6 stores summed sensor readings. Some METER sensor user manuals contain
more details of how the ZL6 processes sensor readings.

NOTE: Setting the ZL6 measurement interval to Off (not logging) turns off sensor measurement, data storage, and
data uploads.

3.2.3 TESTBUTTON

Pressing the TEST button initiates the self-test sequence. The self-test can take 60 s or more
because of testing communications over the cellular network. The following actions are part
of the self-test sequence:

* Reboot the ZL6.

This ensures internal software restarts and operates in the expected way. Both status
lights stay on during the reboot. This reboot will not erase data or reset settings.

« Perform basic functionality testing on internal systems and evaluates the amount of charge
in the battery.

Both the green and red lights blink together slowly while the logger performs tests.
« Autodetect the connected sensors (Section 3.2.1).

« Start the embedded GPS receiver to obtain a current time and location fix (Section 3.2.6).
This process takes as long as15 min to complete.

15
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« Establish an internet connection over the cellular network and attempt to communicate
with ZENTRA Cloud.

After completing the self-tests, the ZL6 will indicate success or failure by lighting either the
green or red status light.

A solid green light (for approximately 20 s) indicates that internal tests passed and there is
successful communication over the cellular network.

A solid red light indicates an error in the logger, which may indicate
e corrupt ZL6 logger firmware

» low batteries, or

« unsuccessful cellular communications.

Use ZENTRA Utility to identify where the self-tests may have failed (Section 4.1) or consult
troubleshooting to resolve logger errors (Section 5.2).

3.2.4 STATUS LIGHTS
Lights near the TEST button indicate the status of the ZL6. A green light is labeled OK and a
red light is labeled ERROR. There are several possible status states:

» The green light gives a short, single blink every 5 s to indicate the ZL6 is configured to log
sensor data.

« The green light blinks slowly (1 s on, then 1 s off), to indicate the logger is communicating to
a computer or using the cellular module.

« The green and red lights blink together during self-test procedures (after pressing the TEST
button or pulling the battery tab).

« At the conclusion of the self-tests, either the green or the red light will remain lit to indicate
the results of the test.

« The lights remain off if the logger measurement interval is set to Off (not logging).

3.2.5 BATTERIES

The ZL6 is designed to use either AA NiMH rechargeable batteries or AA alkaline
nonchargeable batteries. The logger autodetects the type of batteries installed and
automatically adjusts the internal thresholds to represent 100% and 0% battery power.

NOTE: Do not mix NiMH and alkaline batteries together. Do not mix new and old alkaline batteries together.

Use NiMH batteries if the ZL6 will be installed outdoors, where it can harvest solar energy to
charge NiMH batteries. Orient the ZL6 enclosure to expose the solar panel to the maximum
amount of sunlight available. In the northern hemisphere, this typically means that the

data logger will face south;in the southern hemisphere, this typically means that the data
logger will face north. There may be local obstructions that make another orientation more
favorable. The logger will charge the batteries even during periods of low light levels (e.g.,

16
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winter time or heavy overcast conditions). For extended periods of low light, the incoming
energy may be lower than the energy needed to operate the logger. The batteries will buffer
the energy needs of the logger for several months and will return to full capacity as the
incoming energy exceeds the energy needed to operate the logger.

The ZL6 will also harvest energy from the USB connection to a computer. Plugging the logger
into a USB port for several hours will help restore NiMH batteries to full capacity.

Use alkaline batteries if the ZL6 will be installed indoors or in a location where the harvested
solar energy is not sufficient to keep the NiMH batteries charged. Alkaline batteries will last
longer than NiMH batteries that are not being charged (6 to 7 months).

The ZL6 is designed to prioritize sensor measurements over both the GPS and cellular
communications features. If the battery level reaches a critical threshold (showing 0%

in software), the logger will stop using the GPS receiver and the cellular radio. The logger
will continue to make sensor measurements until the battery charge is too low to provide
excitation power to the sensors. When new batteries are installed or recharged, the GPS
receiver and cellular radio functionality will automatically start working again.

Logged data are stored with nonvolatile flash memory and will not be lost if battery power
fails. However, power must be restored to the logger to download data.

3.2.6 GPS RECEIVER

The ZL6 logger has a built-in GPS receiver that provides the latitude, longitude, and altitude
of the logger. It is designed to provide time fix and location metadata for the environmental

monitoring location. The ZL6 does not record the location of each individual sensor reading

and is not optimized for applications such as geotagging a moving sensor platform.

The ZL6 enables the GPS receiver once per day. If the logger determines its location has not
changed, it turns off the GPS receiver to save power. If the ZL6 detects a change, it keeps
the GPS receiver powered for as long as 15 min to improve the accuracy of the location fix.
Pressing the TEST button on the ZL6 triggers the logger to evaluate changes in location
(Section 3.2.3).

3.2.7 TIMEKEEPING

The ZL6 keeps track of time using Universal Time Coordinated (UTC) seconds. The ZL6
synchronizes time using either a computer running ZENTRA Utility, the GPS receiver, or the
cellular network. The ZL6 prioritizes using GPS time since this will be the most accurate;
however, the logger will fall back to the other sources of time when the ZL6 does not have a
good GPS time fix.

Data collected by the ZL6 uses the UTC time for the timestamp on each saved sensor record.

ZENTRA Utility and ZENTRA Cloud display these data using local time based on where the
logger is installed.

17
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3.2.8 DATA STORAGE

The ZL6 only stores data for sensor ports that are configured for sensors (Section 3.2.1).

The ZL6 stores 8 MB of data. When the logger has filled its memory, it begins overwriting
the oldest data in the memory. Data storage varies between approximately 6 months to
over 300 years depending on the sensors used and the measurement interval. ZENTRA
Utility software displays how many days of data the ZL6 can hold based on the current
measurement interval (Section 3.2.2), sensor configuration, and previously stored data.

The ZL6 data memory is nonvolatile flash. Removing the batteries or rebooting the logger
(Section 3.2.3) will not erase stored sensor measurement data.

The ZL6 stores encoded data for each sensor to make data storage and transmitting
convenient. ZENTRA software automatically decodes the sensor data to display
them correctly.

3.2.9 CELLULAR COMMUNICATIONS

The ZL6 has a built-in cellular module for uploading measurement data to ZENTRA Cloud.
This allows for near real-time monitoring of the environment at the measurement site.

The ZL6 powers the cellular module only long enough to upload the data collected since the
last time the logger successfully reported. During these upload times, the ZL6 transfers data
to ZENTRA Cloud, retrieves any pending settings changes, and occasionally performs system
update to the logger.

Upload session frequency and timing can be changed in ZENTRA Utility (Section 4.2.5) or
ZENTRA Cloud. The default setting is for the ZL6 to upload data once per hour at a random
time within each hour of the day. Less frequent uploads conserve battery power.

NOTE: Contact Customer Support if more frequent uploads are needed.

The ZL6 operates with AT&T and T-Mobile networks in the United States. The ZL6 also works
with over 200 roaming partners around the world.

18
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4. ZENTRA SOFTWARE

The ZL6 is designed to work with ZENTRA Utility and ZENTRA Cloud. Both ZENTRA Utility and
ZENTRA Cloud software allow the user to collect and manage data from the device. ZENTRA
Utility is on the included USB drive or can be downloaded from metergroup.com/zl6-support.
ZENTRA Cloud is a web-based application to remotely download spreadsheets, view data,
and configure the ZL6 (Section 4.3).

NOTE: ZENTRA Utility does not communicate with the ZL6 logger over the cellular network and internet. The logger

must be physically plugged into the computer to download data via ZENTRA Utility. Use ZENTRA Cloud to download
ZL6 data when not directly connected to the logger.

4.1 ZENTRA UTILITY

ZENTRA Utility is a user-friendly interface for configuring and downloading data from the
ZL6 logger that can be used on any MacOS (10.9 and above) or Microsoft Windows (7 and
above) laptop, netbook, or desktop computer. With ZENTRA Utility, the user can connect to
ZL6 loggers directly to

« set all logger configuration parameters,
« make real-time sensor measurements (scan sensors), and

« create Excel files with sensor data.

The ZENTRA Utility main screen should appear upon launch (Figure 11). Use the Menu bar
and Button toolbar to interact with the ZL6.

COM port dropdown ~ Site name

Device firmware version — ‘ ’7 Measurement interval
4 ZENTRA Utiiy [E=E(EoR )
Menu bar i oss et actions window tiel Battery status
Button toolbar L —— Download  Settngs  Celllar Test

Device serial number —H-Frzo000s s} KeldnTigs = [\ Data logger
Device name i site 1107 15 minutes < 1% in use. Approdmalely 3.7 years unii verwiing old data identification area
ATIOS 41 Allin-one Weather Station  Solar Radizton Precitation Ligining Acvi Lightning Distance
Port1 4Wim* 0.000 mm 0 0km
Memory usage
ur 015ms 035ms 750

Relative Humidih Atmospheric Pressure X-axis Level Yeaxis Level
027RH 93.22kPa 0 100

Active sensors and

measurements MaxPrecp Rate RH Sensor Temp

000 mmn rE

TEROS 12 MoistureTemp/EC atr Content emperature Saturation Edract EC

Port2 0.129m 68.0°F 0.005 mSicm

Battery Battry Percent Battry Voltage -
1% sasmv

Rarometer Reference Pressire | oot Tomnerature -

Status bar ——— reay 04125/18 122041

Figure 11 ZENTRA Utility main screen
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4.2 BUTTON TOOLBAR

The Button toolbar provides shortcuts for the most frequent actions in using and configuring
the ZL6 (Figure 11):

» COM port dropdown menu: Lists USB devices connected to the computer.

» Connect/Disconnect: Click the Connect button to attempt to connect to the device
currently selected in the COM port dropdown menu. Click the Disconnect button to
disconnect from the currently connected logger.

« Scan: Queries the connected ZL6 for the current sensor readings and updates the active
sensors and measurements area.

» Download: Downloads all data that has been collected on the ZL6 since the last time a
download from the selected logger.

« Settings: Opens the Manage Settings dialog (Section 4.2.5).

» Cellular Test: Opens the Cellular Communication Test dialog (Section 2.3).

‘ 7L6: ZENTRA ZL6 (COM11) Disconnect Scan Download Settings Cellular Test

Figure 12 Button toolbar

4.2.1 DATA LOGGER IDENTIFICATION AREA

The Data Logger Identification area shows information for the connected ZL6. Hover over
each item for its label. Any customizable fields can be adjusted through the Manage Settings
dialog (Section 4.2.5).

» Serial Number: The factory-set unique serial number for each ZL6.

« Device Type: Model ZL6

« Site Name: Customizable field to describe the ZL6 location.

- Remaining Battery Life: Icon that shows the battery charge remaining on the device.

« Cellular Strength: Icon that shows the strength of the cellular signal. This appears only
after the cellular communication test is completed (Section 2.3).

« Device Name: Customizable field to describe the ZL6 device.
« Firmware Version: Version of firmware on the ZL6.

* Measurement Interval: Customizable field that describes the frequency at which the
ZL6 will be recording measurements (Section 3.2.2).

« Time until Overwriting Data: Indicator of how much data are stored on the ZL6 and how
long it will be able to record more measurements before overwriting older data.
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4.2.2 ACTIVE SENSORS AND MEASUREMENTS AREA

All sensors plugged into the ZL6 are listed in this area and each sensor in this section is
delimited by a horizontal bar (Figure 11). The left side of the section will have the sensor
name and port number. The two on-board sensors (Battery and Barometer) will not show a
port number. The right side of the section will list all measurements from the sensor, with
a descriptor of the value. The measurements will use the units selected in the Manage
Preferences Dialog (Section 4.2.4).

4.2.3 STATUS BAR

The Status bar in the bottom border of the screen will include what is happening in the
software. It also shows the logger date and time.

4.2.4 MENU BAR

ZENTRA Utility Menu bar has six menus to access the program features: File, Data, Edit,
Actions, Window, and Help.

FILE MENU
The File menu includes two options:
« Disconnect: Disconnect from a logger and end communications.

« Quit: Closes ZENTRA Utility.

DATA MENU
The Data menu has three options:

» Download Data Since Last Download: Download the data stored since the last successful
download.

« Download All Data: Download all the data currently stored in the ZL6.

« Erase: Deletes all stored data.
Section 2.5 provides instructions for downloading data from the ZL6 logger.

The data downloaded by ZENTRA Utility will be calibrated correctly for each sensor type,
except for soil moisture sensors. ZENTRA Utility uses a default calibration for soil moisture
sensors that is appropriate for most mineral soils, but a custom calibration may be needed
for the particular soil type. If a different soil moisture sensor calibration is necessary, change
the Measurement Units to Raw VWC in the Manage Preferences tab. Raw VWC values will

be downloaded in the Processed Data worksheet for use as inputs to custom calibration
equations. See each specific sensor manual for alternative calibrations that can be applied
to the raw data.
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EDIT MENU
The Edit Menu allows the user to edit preferences in the Manage Preferences dialog. These
preference configurations will only be saved to the computer, not as measuring preferences
in the ZL6 memory. It has four tabs for navigation:
« Measurements Tab (Figure 13):
+ Measurement Units: Set preferences for measurement units by using the dropdown
menus. Click OK to apply the changes.

Manage Preferences @

Measurements ‘ Data File | Application | Communications

Measurement Units

Irrigation Pressure [kFEg (Kilopascal Gauge) v]
Matric Potential [kPa (Kilopascal) v]
Water Content [m’fm’ (Volumetric Water Content) v]
Temperature ['F (Fahrenheit) v]
Distance |km (Kilometers) -

Soil_Media Electrical Conductivity ISaturatmn Extract mS/cm (Millisiemens per Centimeter) ']

Velume lthers v]
Drainage/Water Level Imm (Millimeters) v]
Hurnidity/Vaper Pressure lRH (Relative Humidity) v]
Installation Height/Depth l(m (Centimeters) v]
Precipitation lmm (Millimeters) v]
‘Wind Speed [m."s (Meters per second) v]

[ OK ] [ Cancel ]

Figure 13 Measurements tab

« Data File Tab (Figure 14):

+ Date and Time Display in ZENTRA Utility: Change the format of date and time values
by selecting an option from the dropdown menus. This controls how date and time are
shown in ZENTRA Utility display and in the downloaded files.

22



ZL6

Manage Preferences @

Measurements = Data File | Application | Communicatiens

Date and Time Display in ZENTRA Utility

Display Date/Time  |04/30/181241:13

[ OK ] [ Cancel ]

Figure 14 Data File tab
« Application Tab (Figure 15):

+ Automatic Internet Version Check: Select the checkbox to automatically be notified
when a new ZENTRA Utility version becomes available. Updates can be searched for
manually at any time in the Help menu.

+ Automatic Clock Synchronization: Select the checkbox to keep the device clock
synchronized with the connected computer clock. The date and time can also be
updated by using the Actions menu.

If the computer will not always have the correct time zone setting for the logger sites,
deselecting this option will not override the setting in the logger.
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Manage Preferences @
Measurementsl Data File | Application | Communications

Automatic Internet Version Check

[VIiCheck for updztes to this Utility as program starts,

Automatic Clock Synchronization

Keep instrument's clock synchronized to PC,

[ OK ] [ Cancel ]

Figure 15 Application tab
» Communications Tab (Figure 16):

+ Device Commands Retries: Modifies the number of times ZENTRA Utility sends
commands to a logger.

+ Extra Response Time: Modifies the length of time ZENTRA Utility waits for a response
from the logger.

+ Communication Ports List: Enable this option if the USB device does not appear in the
Connect dropdown list.

NOTE: Enabling this option may also find COM ports that are unavailable for use by ZENTRA Utility.

+ Power Noise Filter: Set the Power Frequency to eliminate electrical noise that comes
from an AC power distribution system.

In North America and most of Asia, the frequency of the power cycle is 60 Hz (the default
value); in most of Europe it is 50 Hz. This feature only needs to be set once, and the
program will automatically update each connected device filter.
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Manage Preferences @

Measurements I Data File | Application | Communications

Only change these settings if you are having trouble
communicating reliably with your device,

Device Commands Retries
Direct Connect Retries j(default] o

Extra Response Time [ ceconds (default)

Communication Ports List

Enable "Force find all communication ports” if your USB
device doesn't appear in the Connect drop down list. Please
note: enabling this option may alse find COM ports that are
unavailable for use by ZEMTRA Utility.

[ Force find all communication ports

Power Maoise Filter

Power Frequency |60 Hz Power h

[ OK ] [ Cancel ]

Figure 16 Communications tab

ACTIONS MENU

The Actions menu is the primary menu for configuring and testing the ZL6 series logger.

- Select Sensors: Displays the Sensor Configuration tab in the Manage Settings dialog
(Section 4.2.5).

» Set Device Time: Instructs ZENTRA Utility to set the ZL6 time and date according to the
time and date on the computer.

« Digital Sensor Terminal: Sends commands through the ZL6 logger to a compatible METER
digital sensor.

This feature can be used to troubleshoot the sensor by sending SDI-12 digital sensor
communication commands. See respective sensor documentation for additional
information on SDI-12 commands.

« Cellular Test: Evaluates the ZL6 logger wireless signal (Section 2.3).

« Cellular Configure: Displays the Communication Settings tab in the Manage Settings dialog
(Section 4.2.5).

« List Cellular Carriers: Queries the cellular module in the ZL6 logger for a list of carriers it
detects. This is useful when trying to troubleshoot cellular connection problems.

NOTE: The ZL6 may not be authorized to operate on any or all the carriers listed.

« Device Information: Displays the Device Information tab in the Manage Settings dialog
(Section 4.2.5).
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« Device Location: Displays the GPS Location tab in the Manage Settings dialog
(Section 4.2.5). These are read-only fields because the logger has an on-board GPS module.

» Show Raw Data/Show Processed Data: Toggle showing raw or processed data in the
instantaneous measurements area of the main screen. Use the raw data display to help
troubleshoot poor sensor measurements.

WINDOW MENU

The Window menu provides the Show Terminal option. This allows for direct entry of
commands to the ZL6 and is mainly used for troubleshooting.

HELP MENU

The Help menu has five options.

» Check for Software Updates: Checks for the newest available version of the ZENTRA Utility.
If a newer version is available, a prompt will appear to install the update. The computer
must be connected to the internet for this feature to work. ZENTRA Utility checks for
newer versions of the program each time it launches. It will download these updates in the
background automatically.

» Check for Logger Firmware Updates: Checks for the newest version of ZL6 firmware
from METER. If a newer version is available, ZENTRA Utility downloads the firmware in
the background.

When ZENTRA Utility connects to an ZL8, it compares the firmware on the logger with the
latest version available. If the ZL6 firmware is out of date, ZENTRA Utility will prompt to
start a firmware update for the logger. ZENTRA Utility maintains a cache of logger firmware
to allow field firmware updates without a connection to the internet.

» Update Sensor Firmware: Some METER sensors (e.g., ATMOS and TEROS sensors) allow
for firmware updates via ZENTRA Utility. Please consult the sensor user manual for
more details.

» Send Feedback to METER: Sends product feedback, bug reports, or feature requests to
METER when connected to the internet (Figure 17).
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Send Feedback to METER =5
Name Company Name
|
Email Address Telephone
Type of Feedback Please Respond Via
General Feedback '] {No Response Needed -

Please Describe the Feedback Below

Send the Following File (Must Be Smaller Than 8 MB):

Select File

Send the Feedback to My METER Representative's Email Address

support.envircnment@metergroup.com

Figure 17 Send Feedback to METER Group window

Enter name, company name, and contact information in the form.

Identify the type of feedback being sent (general feedback, feature suggestions, bug report,
or other).

Indicate if and how METER should respond (email or telephone).

Give details in the description area. If reporting a bug, detail what steps occurred prior to
the bug and any error message. By default, bug reports include software error files. Other
files can also be sent using this form (e.g., logger download files).

» About ZENTRA Utility: View the version of ZENTRA Utility currently installed.

4.2.5 MANAGE SETTINGS DIALOG

Changing the ZL6 configuration happens in the Manage Settings dialog, which has four tabs.
Use the following steps to access the Manage Settings dialog:

1. Click Settings on the Button toolbar (Section 4.2).

2. Make edits to the settings on the tabs. Refer to the details about the types of control
settings in the following sections.

3. Click OK to save settings.
Click Cancel to exit without applying settings.
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DEVICE INFORMATION TAB

Use the Device Information tab to edit the information that appears in the Data Logger
Identification area (Figure 18).

» Device Name: Logger-specific name to identify the logger in the software. The default name
is the unit serial number. It can be changed to a name representing the field or plot where
the logger is installed or the types of sensors installed.

« Site Name: Area-specific name to identify where a group of loggers are located in the
software. The Site Name is optional.

 Serial Number: Factory-set logger serial number that cannot be changed.

» Time Zone: Time zone automatically set from ZENTRA Utility software or the cellular
system.

» Firmware Version: Version of firmware on the ZL6. Check for the latest version of logger
firmware, using the Help menu (Section 4.2.4).

« Device Type: Model of the ZENTRA logger connected to ZENTRA Utility (not editable).

Manage Settings 2|
{Device Information | Sensor Configuration | Communication Settings | GPS Location
Device Name South Site
Site Name Keldin Trials
Serial Humber 26-00004
Time Zone utc-7
Firmware Version 1107
Device Type ZL6
oK [ cancel |
Ready

Figure 18 Manage Settings Device Information tab

SENSOR CONFIGURATION TAB

Use the Sensor Configuration tab to set the sensor measurement interval and to select
sensors for each port (Figure 19).

« Measurement Interval: Controls how often the ZL6 stores sensor data (Section 3.2.2).

NOTE: Setting the ZL6 measurement interval to Off (not logging) turns off sensor measurement, data storage, and
data uploads.
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- Data Storage: Shows the percentage of logger storage currently used and an approximation
of when the logger will begin overwriting the oldest data. This calculation is based on the
data already stored, measurement interval, and existing sensor types configured in each
port of the logger.

« Sensor port tabs: Displays sensor type and firmware version (when applicable) for each
sensor port on the logger. Select the correct sensor type from the dropdown menu to
ensure correct sensor measurements.

NOTE: Only digital sensors have firmware versions.

Manage Settings [ )fes)
Device Information Sensor Configuration | Communication Settings | GPS Location
Measurement Interval 15 minutes -
Data Storage: 05%in use. - App 3.7 years until o g old data
Portl |port2 |Port3 [Ports | Port5 [ Ports |
Sensor Type { ATMOS 41 All-in-one Weather Station )
Firmware Version

Ready

Figure 19 Manage Settings Sensor Configuration tab

COMMUNICATION SETTINGS TAB

Use the Communication Settings tab to control upload frequency and times for the

ZL6 (Figure 20).

» Upload frequency for each selected hour: Enable or disable automatic data uploads from
the ZL6 to ZENTRA Cloud. The Upload Frequency describes how often data are uploaded
and is a different setting than the sensor measurement interval. Data are sent once per
hour. If more frequent uploads are needed, please contact Customer Support. METER offers
cellular service plans that support uploading data every 15 min.

« Upload Times: Choose the approximate times of day that data are uploaded from the logger
to ZENTRA Cloud. The data will be uploaded at a random time during each selected hour to
upload data. To account for this variation, choose times prior to when the data are needed.
By default, the ZL6 is configured to upload data each hour. To conserve battery power,
choose fewer Upload Times.
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Manage Settings 2|

Device Information Sensor Configuration | Communication Settings | GPS Location

Upload frequency for each selected hour:

One data upload per hour (default)} h

Upload Times (Choose up to 24, choose fewer to save battery life)

,—-

WA Ty
10\\\ ‘

\\l|H/,

m\\

// 2 // 2
= ~Z =~ ~Z
— am — s — PM —
Z </ \: B
5, \ g // e
/H‘l\\ / ffr|1\\\ /

\-ﬁ/
APH wyless.apn
APN User

Ready

Figure 20 Manage Settings Communication Settings tab

GPS LOCATION TAB

Allinformation in this tab are automatically provided by the GPS receiver in the ZL6 and are
read only (Figure 21).

« Latitude and Longitude: Provides GPS location of the ZL6.

« Altitude: Contains altitude from sea level of the ZL6.

« Time Zone: Offset from UTC time zone of the ZL6.
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Manage Settings 2|

Device Information Sensor Configuration | Communication Settings | GPS Location

Latitude:

Longitude:

Altitude:

Time Zone: uTc-7

0K Cancel

Ready

Figure 21 Manage Settings GPS Location tab

4.3 ZENTRACLOUD

ZENTRA Cloud is a cloud-based web application to download, view, and share ZL6 data as
well as change logger configurations. ZENTRA Cloud is also designed to make it easy to share
data with colleagues. A 3-month trial of ZENTRA Cloud is included with each ZL6 purchase
that begins with the first logon to ZENTRA Cloud. This manual offers only instructions to
logging in to ZENTRA Cloud. Use the online help files to learn more about all the features of
ZENTRA Cloud.

The first step to using the ZL6 with ZENTRA Cloud is to create a customer site (a group of
users and loggers).

1. Navigate to zentracloud.com.

2. Click the Sign Up button on the left side of the screen.

3. Enter the required information, including a valid email address.
4. Accept the terms and conditions.
5

Click Sign Up.
ZENTRA Cloud will send an email confirmation.

6. Click the link in the confirmation email inside email application.

7. LogintoZENTRA Cloud.
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To view data from ZL6 loggers on the customer site, subscribe to each desired ZL6 logger on
ZENTRA Cloud following the steps below. A logger can only belong to one site at a time.

NOTE: Depending on the organization, labels may be Farm and Field or Site and Plot. These designations can be
changed at any time.

1.
2.

Select New Farmon the lower left corner of the ZENTRA Cloud home screen.

Give the Farm a name.
A Farm can contain one or more Fields.

Select New Field from the button on the lower left corner.
Associate this Field to the Farm.

Give the Field a name.
A Field can contain one or more loggers.

Select New Subscription from the button the lower left corner.
Choose the Farm and Field.

Fill in the ZL6 Device Serial Number and Device Password as shown on the device
subscription card (Figure 22).

Figure 22 Sample device subscription card

Once subscribed to a ZL6, the logger should appear on the map and sensor data can be
viewed and downloaded. Logger settings can be changed using ZENTRA Cloud. ZENTRA
Cloud also provides a convenient way to share data from ZL6 loggers with colleagues, with
user-set permissions. See the online help files for more information.
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5. SERVICE

This section describes the maintenance of the ZL6. Troubleshooting solutions and
customer service information are also provided.

5.1 MAINTENANCE

The ZL6 may be returned to METER for maintenance (inspect system, replace old or damaged
parts). Select replacement parts (e.g., USB cable, antenna, case enclosure, gaskets) can also
be ordered from METER. Contact Customer Support for more information. ZENTRA Utility
makes it easy to send feedback, bug reports, and feature requests to METER (Section 4.2.4).

The ZL6 requires little maintenance when installed correctly. Be sure to check ZL6 logger
periodically:

» Replace batteries as needed.

« Inspect the battery holders to ensure they are clean and free of corrosion.

« Verify that the sensor ports are clean and that the sensors are making good contact with
the ports.

« Clean the inside of the sensor ports with isopropyl alcohol and a swab if soil or other
foreign materials are visible.

» Check case gaskets and strain relief hooks. Replace gaskets every 1 to 2 years, as needed.

» Replace zip ties securing the logger annually or as needed.

NOTE: Never immerse the ZL6 in liquids or bury the ZL6. This and other misuse, improper protection, or improper
installation may damage the ZL6 and void the manufacturer’s warranty.

NiMH batteries should last for several years if they are charging properly. Over a long period
of time, NiMH batteries will begin to lose their charge capacity. If dark periods lasting
months cause the batteries to discharge too low, it is time to replace the NiMH batteries.
When replacing NiMH batteries, use high-quality batteries advertising higher charge
capacity. New NiMH batteries may also be purchased from METER. Contact Customer
Support to discuss concerns or recommendations.

Alkaline batteries should be replaced when the battery charge nears 0%. Replace batteries
with high-quality alkaline batteries. A low-quality battery may not provide the desired
battery life for the ZL6 logger.

NOTE: Do not mix NiMH and alkaline batteries together. Do not mix new and old batteries together.

NOTE: Installing or replacing the batteries in the ZL6 resets the internal real-time clock. The ZL6 time can be set
from ZENTRA Utility, the on-board GPS receiver, and the cellular network. Press the TEST button after changing the
batteries to enable the GPS receiver to acquire a new time and position fix.
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5.2 TROUBLESHOOTING

Although the ZL6 is designed for durability and built to the highest manufacturing standards,
problems may occasionally occur. This troubleshooting section details the major problems
and their solutions. If the problem is not listed or these solutions do not solve the issue,
contact Customer Support.

Table2 Troubleshooting the ZL6
Problem Possible Solutions

If using a Windows computer, reinstall the USB driver from
metergroup.com/zl6-support.
Mac computers running ZENTRA Utility do not require a custom USB
driver.

ZENTRA Utility cannot

. NOTE: The Em50 driver and USB Cable Adapter will not work for the ZL6.
connect to the device

Check that the USB cable is securely plugged into the logger and the

or computer.
ZL6 logger not showing in Ensure the logger has good batteries.
the COM port picker Press the TEST button on the logger to reset it.

Connect to a second logger. If the connection works, the problem is
likely with the first logger.

Try a different micro-USB cable. Ensure the cable is not intended for
charging only.

Check or replace the USB cable.

Increase the number of times ZENTRA Utility tries sending commands
ZENTRA Utility reports it to the logger:
lost the connection « Go to the Manage Preferences menu.

« Select the Communication tab.

« Increase the Direct Connect Retries.

ZENTRA Utility states Wait for at least the length of the measurement interval to ensure the

there is no new data for logger had enough time to record data.

downloading Ensure the logger is configured to measure data, i.e., make sure the
measurement interval is not set to Off (not logging).

or
Check the battery. The ZL6 will stop making sensor measurements

Logger stopped making when the batteries are extremely low.

measurements

Press the TEST button to reset the logger.
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Table 4 Troubleshooting the ZL6 (continued)

Problem

Sensor data shows No
response from sensorin
the Scan window

or

Downloaded data shows
#N/A

Sensor measurement
data does not seem to
be correct

Red ERROR light and/
or green OK light are
always on

Red ERROR light is on
after pressing the TEST
button

Cellular uploads stopped
working

Logger does not seem
to be working correctly
or reliably

Possible Solutions

The raw data measured by the logger is out of expected range for the
sensor. This could be caused by an unplugged or broken sensor.

Ensure the sensor stereo plug is fully inserted into the logger
sensor port.

Ensure the sensor type shown in the Scan window matches the sensor
connected to the logger.

Switch the sensor to a known working port and scan again. If the
sensor shows data, the port may be damaged. If the No response
from sensor message is still presenting, the sensor could be
unplugged or broken.

If the problem persists, contact Customer Support.

Switch the sensor to a known working port and scan again. If the
problem follows the sensor, then the sensor may be damaged.

Many issues affect the quality of the sensor measurement. Please
see the sensor user manual for troubleshooting.

Check logger batteries.
Press the TEST button to reset the ZL6.

If the problem persists, contact Customer Support.

See Section 3.2.3 for information on the TEST button results and how
to further troubleshoot.
Press the TEST button to reset the ZL6.

Run the Cellular Communication Test in ZENTRA Utility to determine if
there is a communication error.

Check the List Cellular Carriers in ZENTRA Utility to confirm there are
cellular carriers operating in the area.

If the problem persists, contact Customer Support.
Press the TEST button on the logger to reset the ZL6.

Check logger batteries. Replace alkaline batteries if close to 0%.
Recharge NiMH batteries if close to 0%.

Check for corrosion or water damage. Check that the seals and
gaskets are intact.

If the problem persists, contact Customer Support.
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5.3 CUSTOMER SUPPORT

Customer service representatives are available for questions, problems, or feedback Monday
through Friday, 7 am—-5 pm Pacific time.

Email: support.environment@metergroup.com
sales.environment@metergroup.com

Phone: +1.509.332.5600
Fax: +1.509.332.5158

Website: metergroup.com

If contacting METER by email, please include the following information:

Name Email address
Address Instrument serial number
Phone Description of the problem

NOTE: For ZL6 sensors purchased through a distributor, please contact the distributor directly for assistance.

5.4 TERMS AND CONDITIONS

By using METER instruments and documentation, you agree to abide by the METER Group,
Inc. USA Terms and Conditions. Please refer to metergroup.com/terms-conditions for details.
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APPENDIX A. COMPLIANCE CERTIFICATIONS

This appendix contains compliance statements that apply to the ZL6.

A.1 USA

The following FCC statement applies to the ZL6. This device complies with Part 15 of the FCC
Rules. Operation is subject to the following conditions:

1. This device may not cause harmful interference.

2. This device must accept any interference received, including interference that may cause
undesired operation.

The ZL6 series loggers contain one or more of the following radio modules, listed by their FCC
identification numbers:

« SH6MDBT4O0 (all ZL6 series)
« XPYLISAU201 or XPYLISAU200

Changes or modifications to the ZL6 series loggers not expressly approved by METER Group, Inc.
USA could void FCC compliance and thus the user’s authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses,

and can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications.

There is no guarantee that a particular installation will not cause any interference. If this
equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, METER encourage users to attempt to
correct the interference by trying one or more of the following measures:

« Increase the separation between the equipment and receiver

» Consult Customer Support
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A.2 CANADA

Industry Canada (IC) Notices
This Class B digital apparatus complies with Canadian CAN ICES-3(B) / NMB-3(B) and RSS-210.
Operation is subject to the following two conditions:

« this device may not cause interference

« this device must accept any interference, including interference that may cause undesired
operation of the device

The ZL6 series loggers contain one or more of the following radio modules, listed by their IC
identification numbers:

8017A-MDBT40 (all ZL6 series)

8595A-LISAU201 or 8595A-LISAU200N

Radio Frequency (RF) Exposure Information
This device has been evaluated and shown compliant with the IC RF Exposure limits under
mobile exposure conditions (antennas are greater than 20cm from a person’s body).

Avis d’Industrie Canada (IC)
Cet appareil numérique de classe B est conforme aux normes canadiennes CAN ICES-3(B) /
NMB- 3(B) et RSS-210.

Son fonctionnement est soumis aux deux conditions suivantes:
« cet appareil ne doit pas causer d’interférence

« cet appareil doit accepter toute interférence, notamment les interférences qui peuvent
affecter son fonctionnement

Informations concernant l'exposition aux fréquences radio (RF)
Ce périphérique a été évalué et démontré conforme aux limites d’exposition aux fréquences
radio (RF) d’IC lorsqu’il est installé dans des produits hotes particuliers qui fonctionnent
dans des conditions d’exposition & des appareils mobiles (les antennes se situent a plus de
20 centimétres du corps d’une personne).

Changes or modifications to the ZL6 series loggers not expressly approved by METER Group,
Inc. USA could void Industry Canada (IC) compliance and thus the user’s authority to operate
the equipment.

A.3 EUROPEAN UNION

R&TTED and European Conformance CE mark
Radiofrequency radiation exposure Information: this equipment complies with radiation
exposure limits prescribed for an uncontrolled environment for fixed and mobile use conditions.
This equipment should be installed and operated with a minimum distance of 20 cm between
the radiator and the body of the user or nearby persons. This transmitter must not be co-located
or operating in conjunction with any other antenna or transmitter except as authorized in the
certification of the product.

A full CE declaration of conformity for the ZL6 is available on request from METER Group.
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A.4 JAPAN
TELEC (Japan)

&

The ZL6 series loggers contain one or more of the following radio modules that are TELEC/JATE
certified.

ALl ZL6 series:
« Technical Requirements certified type number = 204-420020

ZL6 with TELEC-approved cellular module:
« Technical Conditions certified type number = AD120274003

« Technical Requirements certified type number = 003-120375
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